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Kinetic Evaluation 5.2 
 

1 – Introduction 

 

Kinetic Evaluation (KE) is the data analysis application that is bundled with the 

Autolab SPR Software. 

 

This version of KE has been redesigned incorporating the functionality of the 

previous versions of KE while introducing new analysis techniques and improving the 

overall workflow of the system. 

 

The remaining sections of this manual are divided into the following topics: 

 

 Section 2, Working with KE – This section describes the components that 

make up the user interface of the Kinetic Evaluation application. 

 

 Section 3, Getting Started with the KE Workflow – This section provides an 

example of a typical workflow with the software. This example starts with 

opening data files and proceeds to fitting interaction plots using the Analysis 

Wizard. 

 

 Section 4, Working with Data – An overview of all the file types that the KE 

application can open, create, and save. 

 

 Section 5, Analyzing the Data – Description of the available analysis tools 

within the KE application. The Modeling Wizard, used to create kinetic 

models; the Signal Processing tool, used to improve data quality; and the 

various Analysis Wizards, used to determine kinetic binding constants. 

 

 Section 6, Calibration – A description of calibration curves that can be used in 

analyses. 

 

 Section 7, Van’t Hoff Analysis – A description of analyses versus temperature 

that measures thermodynamic properties. 
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2 – Working with KE 

 

In this section introduces the user interface of the KE application. The navigation via 

various menus and toolbars will be described in the following subsections. 

 

2.1 – User Interface Overview 

 

Figure 2.1 is a typical screenshot of the KE application. In this section each of the 

numbered regions in the figure will be explained. 

 

 
 

Figure 2.1 - Screenshot of the Kinetic Evaluation application 

 

The following descriptions correspond to the numbers that appear in Figure 2.1. 

 

1.) Opened Files – Files that have been opened are added as tabs. The data within 

these files are graphed within the tabs. For more information about the file 

types that KE supports, see section 4. 

 

2.) Main Menu – All the functionality of the KE application is accessible via the 

main menu (see section 2.2 for more information). 

 

3.) Toolbar – The buttons in the toolbar represent KE functionality (see section 

2.3 for more information). 

 

4.) Activity Bar – Provides quick access to commonly used functionality. The 

functions in the Activity Bar are grouped into common themes (see section 2.4 

for more information). 
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5.) Project Navigation Bar – Provides a method to view the data that is stored in 

a Project file (see Section 2.5 for more information). This Navigation Bar is 

only displayed when a Project file (see section 4.5) is in focus. 

 

2.2 – Main Menu 

 

The main menu provides functionality to access all the features of KE. Figure 2.2 

below is a screenshot of the Main Menu. 

 

 
 

Figure 2.2 - Main Menu of KE 

 

The following subsections describe the Main Menu items. 

2.3 – File Menu 

 

The File menu contains functionality that is required to work with files in the KE 

application. The screenshot below depicts the File menu. 

 

 
 

Figure 2.3 - Main Menu  File 

The table below on this page provides an overview of the File menu items. 

 
Table 2.1 – Overview of the File Menu Items 

 

Menu Item Description Additional 

New  Overlay… Displays the Overlay Builder dialog  Figure 2.4 

Section 4.4 

New  Project… Displays the Project Builder dialog Figure 2.4 

Section 4.5.1 

New  Calibration… Displays the Calibration Builder 

dialog 

Figure 2.4 

Section 4.5.2 
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Open  Measurement Opens a Measurement file from disk Figure 2.5 

Section 4.3 

Open  Overlay Opens an Overlay file from disk Figure 2.5 

Section 4.4 

Open  Project 

(including Van’t Hoff) 

Opens a Project file from disk Figure 2.5 

Section 4.5 

Open  Calibration Opens a Calibration file from disk Figure 2.5 

Section 4.5.2 

Close Closes the file in the visible tab   

Close All Closes all open files  

Save Saves the file in the visible tab   

Save As… Saves a copy of the opened file with a 

new name 

 

Save All Saves all open files  

Print Preview… Opens the Print Builder Dialog Section 4.7 

Print… Opens the Print Builder Dialog Section 4.7 

Exit Exits the KE application  

 

 

The FileNew menu item contains sub-menu items as shown in Figure 2.4. To access 

these items, click the New menu item and the sub items will appear. 

 

 
 

Figure 2.4 – File  New Menu 

 

The FileOpen menu item also contains sub-menu items (Figure 2.5). 
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Figure 2.5 – File  Open menu 

 

2.3.1 – View Menu 

 

The View menu item contains functionality to show/hide various components of the 

KE application. The screenshot below shows the View menu. 

 

The View menu contains different items depending on the file type being displayed. 

Figures 2.6, 2.7, and 2.8 are screenshots of the three different View menus for each 

file type. 

 

 
 

Figure 2.6 - Main Menu  View (Measurement file) 

 

The table below provides an overview of the View menu items. 

 

 

 
Table 2.2 – Overview of the View Menu Items 

 

Menu Item Description Additional 
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Legend 

 

Show/Hide the graph legend 

Legend is not 

available for 

Analysis files 

 

Chart Properties 

 

Show the Chart Properties dialog 

Measurement files 

do not have chart 

properties. 

See Section 4.6 

 

Interaction Plots 

Shows the data of the file in a graph. 

Measurement files have the option to 

show/hide plots 

 

See Section 4.2.1 

Data Points Show a grid containing the files data 

points 

See Section 4.2.2 

Event Log / 

History / 

Summary 

Depending on the file type this view 

shows additional data about the file 

See Section 4.2.3 

Toolbar Show/Hide the Toolbar See Section 2.3 

Activity Bar Show/Hide the Activity Bar See Section 2.4 

Options… Opens a dialog to allow the user to reset 

the application settings 

 

 

The View menu for an Overlay file provides access to the Chart Properties as shown 

in the figure below. 

 

 
 

Figure 2.7 - Main Menu  View (Overlay file) 
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The View menu for an Analysis file. 

 

 
 

Figure 2.8 - Main Menu  View (Analysis) 

 

2.3.2 – Tools Menu 

 

The Tools menu provides access to functionality to analyze data. The screenshot 

below portrays the Tools menu. 

 

 
 

Figure 2.9 - Main Menu  Tools 

 

The table below provides an overview of the Tools menu items. 

 
Table 2.3 – Overview of the Tools Menu Items 

 

Menu Item Description Additional 

Analysis Wizard Opens the Analysis Wizard dialog See Section 5.3 

Calibration Wizard Opens the Calibration Wizard dialog See Section 6 

Modeling Wizard Opens the Modeling Wizard dialog See Section 5.1 

Signal Processing Opens the Signal Processing dialog See Section 5.2 

Van’t Hoff Wizard Opens the Van’t Hoff Wizard dialog See Section 7 

Manage Overlays Opens the Manage Overlay dialog See Section 4.4.1 

 

2.3.3 – Help Menu 
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The Help menu provides access to the KE’s online help system. The screenshot below 

shows the Help menu. 

 

 
 

Figure 2.10 - Main Menu  Help 

 

The table below provides an overview of the Help menu items. 

 
Table 2.4 – Overview of the Help Menu Items 

 

Menu Item Description Additional 

Search… Opens the online help system and 

shows the Search tab 

 

Contents… Opens the online help system and 

shows the Contents tab 

 

Index… Opens the online help system and 

shows the Index tab 

 

About Kinetic 

Evaluation 

Opens the About dialog Provides the KE 5.1 

number 

 

  



Autolab SPR – KE User manual  9 

  

 

2.4 – Toolbar 

 

The Toolbar contains buttons that launch KE functionality. The screenshot below 

illustrates the Toolbar. 
 

 
 
 

Figure 2.11 – KE Toolbar 

 

The following gives an overview of the items in the Toolbar. 

 

 
Creates a new Overlay or Project file depending on which type the 

user chooses 

 

 
Opens a Measurement, Overlay or Project file depending on which 

type the user chooses (see section 4.1.2) 

 

 Saves the file in the visible tab  

 

 
Saves all the open files 

 

 

The default mode of the graph. When moving the mouse pointed 

over the graph, the coordinates (x,y) will be displayed next to the 

mouse icon 

 

 
Sets the graph to Zoom-mode. Left-click and dragging the mouse 

pointer will zoom in on the selected region 

 

 

Sets the graph to Select-mode. Left-click and dragging the mouse 

pointer will select an area of the graph 

 

 Shows/Hides the graph legend 

 

 Displays the Chart Properties dialog (see Section 4.6) 

 

 
Creates a sub curve from the selected area of a measurement file 

(see Section 4.3.2) 

 

 
Launches the Manage Overlays dialog (see Section 4.4.1) 
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2.5 – Activity Bar 

 

The Activity Bar, as shown in Figure 2.12, is used to access commonly used KE 

functionality. 

Activity Bar items are enabled or disabled based on the currently displayed file. If the 

displayed file does not support a certain action (for example you cannot run the 

Analysis Wizard on a measurement file) the item will be disabled. 

 

 
 

Figure 2.12 – KE Activity Bar 
 

The table below provides an overview of the Activity Bar. 
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Table 2.5 – Activity Bar Items 

 

Section Action Description 

Create 

Files 

New Overlay Launches the Overlay Builder dialog 

New Project Launches the Project Builder dialog 

New Calibration Launches the Calibration Builder dialog 

 

 

 

 

Open Files 

 

Measurements 

Opens a measurement file from disk. The 

number to the right of shows the number of 

opened measurement files. 

 

Overlays 

Opens an Overlay file from disk. The number to 

the right shows the number of opened overlay 

files. 

 

Projects 

Opens a Project file from disk. The number to 

the right shows the number of opened project 

files. Use this to open Van’t Hoff Project files 

as well as normal Project files. 

Calibrations Opens a Calibration file from disk. The number 

to the right shows the number of opened 

calibration files. 

 

 

Views 

View Interaction Plot Shows the data from the file in a graph 

View Data Points Shows the data points from the file in a grid 

View Event Log / 

History / Summary 

Shows additional information about the file. 

Different files contain different information 

 

 

Analysis 

Analysis Wizard Launches the Analysis Wizard 

Modeling Wizard Launches the Modeling Wizard 

Calibration Wizard Launches the Calibration Wizard 

Signal Processing Launches the Signal Processing dialog 

Van’t Hoff Wizard Launches the Van’t Hoff Wizard  

 

Figure 2.13 shows the startup state of the Activity Bar. In this state the New Overlay 

action is disabled because a prerequisite is that there must be at least one 

measurement file open. 
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Figure 2.13 - Startup state of the Activity Bar 

 

2.6 – Project Navigation Bar 

 

Project files (section 4.5) can contain more than one file. Since there are multiple files 

there must be a way to navigate through them. 

 

When a project file is in focus, the navigation bar will be shown on the right of the 

screen, as shown in Figure 2.14 below. 

 

 
 

Figure 2.14 - Project Navigation Bar 

 

The Navigation Bar provides links to the data within a project. These links in the 

Navigation Bar are grouped into categories. 

 

The Overlay files will appear directly below the name of the project file. For normal 

projects, there is only one overlay. For Van’t Hoff projects, there can be more than 

one overlay. In Figure 2.14, the name of the overlay file is A+B=AB__3plots.kod. 
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The next groups are the analyses that have been performed on the Overlay data. The 

analyses are grouped into Association, Equilibrium and Dissociation analysis. The 

project in Figure 2.14 contains two association analyses, one equilibrium and no 

dissociation analysis. 

 

2.6.1 – Editing Navigation Bar Items 

 

Editing the items in the Project Navigation Bar can be performed by right-clicking on 

the item to display a pop-up menu (as shown in Figure 2.15 below). 

To rename an item, right-click on the item and select Rename. The item’s name will 

be highlighted and the new name can be entered. 
 

 
 

Figure 2.15 - Renaming a Project Component 

 

2.6.2 – Removing Navigation Bar Items 

 

It is possible to remove an item from a Project via the navigation bar. To remove an 

analysis (it is not possible to remove the overlay) right-click on the analysis and select 

Remove from the pop-up menu (see Figure 2.16). A confirmation will be required to 

complete the removal. 
 

 
 

Figure 2.16 - Removing an Analysis from a Project 
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2.6.3 – Reanalyzing an Analysis 

 

To reopen one of the analyses in a Project, double-click on the analysis name and it 

will be reloaded in the Analysis Wizard (see section 5.3). 

Note 

It is not possible to remove the Overlay file from a Project. 

 

This is done in order to guarantee that the analyses in the Project are always 

linked to the correct Overlay file. 
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3 – Getting Started with the KE Workflow 

 

This section of the user manual gives an overview of a typical session using the KE 

application. 

 

The following flowchart describes the workflow in this section. 

 

Open 

Measurement Files

Analysis Wizard to 

fit the Interaction 

Plots

Create a Project 

File with the 

Overlay

Signal Processing 

of Overlay

Create an Overlay 

File

 
 

Figure 3.1 - Standard KE Workflow 

 

3.1 – Opening Measurement Files 

 

In this step we will be loading SPR measurement files into the KE application. 

 

a.) Click on the Measurements item in the Activity Bar as shown in the 

screenshot below: 

 

 
 

Figure 3.2 - Selecting the Measurements item 
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b.) The measurement files for this example are located in the…/Autolab 

SPR/Data folder. On the Open dialog change the Files of type to: Data files 

(*.ibo). Select the following data files to open: KIN101.ibo, KIN102.ibo, 

KIN103.ibo, KIN104.ibo, KIN105.ibo, and click Open. 

 

c.) The five files that were opened into the KE application are shown in the 

screenshot below. Notice that there is now the number “5” beside the 

Measurements item to indicate the number of files opened. 
 

 

 
Figure 3.3 - Data Loaded in the KE Application 

 

3.2 – Creating an Overlay 

 

In this step the five measurement files that were opened will be used to create a new 

overlay file. 
 

a.) Click the New Overlay item in the Activity Bar as shown in the screenshot 

below. 
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Figure 3.4 - Selecting the New Overlay item 
 

b.) Example of a new overlay using the Channel 1 data from each of the 

measurement files. Select the Channel 1 checkboxes for each measurement as 

shown in the screenshot of the overlay builder below. Once all the Channel 1’s 

have been selected click the OK button. 

 

 
 

Figure 3.5 - Selecting the Plots for the New Overlay 

 

c.) A new overlay file will be created and added. Notice in the screenshot below 

that there is now a “1” beside the Overlays item in the Activity Bar. 
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Figure 3.6 - The New Overlay 

 

d.) You can save this overlay to disk by clicking the Save Toolbar icon. 
 

3.3 – Perform Signal Processing 

 
The overlay created contains an offset. This can be removed by using the Signal 

Process feature in KE.  

 

a.) To open the Signal Processing dialog, click the Signal Processing item in the 

Activity Bar as shown in the figure below. 
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Figure 3.7 - Selecting the Signal Processing item 

 

b.) The Signal Processing routine to remove the baseline offset is called Zero at 

Average. Select this action from the list as shown in the figure below. 

 

 
 

Figure 3.8 - Selecting the Zero at Average Option 
 

c.) The Zero at Average will take the average of the selected area and subtract this 

amount from the entire plot. Select a region in the flat part of the overlay using 
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the Selection tool and click the Apply button. The screenshot below shows the 

selection of the area that will be averaged. 

 

 
 

Figure 3.9 - Selecting a Region for the Average to be calculated 
 

d.) The Overlay’s baseline should be now zero, as shown in the figure below. 

Click OK to close the Signal Processing dialog. 

 

 
 

Figure 3.10 - The Corrected Baseline of the Overlay 
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3.4 – Create a Project File 

 

In this step the Overlay file will be added to a new Project file. 

 

a.) Click the New Project item in the Activity Bar as shown in the screenshot 

below. 

 

 
 

Figure 3.11 - Selecting the New Project item 

 

b.) Select your Overlay in the dropdown box in the Project Builder dialog as 

shown in Figure 3.12. Press OK to create the new Project. 

 

 
 

Figure 3.12 - Creating a new Project with the Project Builder 

 

c.) The new Project will be created and displayed in the KE application as shown 

in Figure 3.13. A copy of the Overlay has been added to the Project. Any 

changes to the Overlay in the Project file will not affect the original Overlay 

file. 
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Figure 3.13 - The New Project File 

 

3.5 – Using the Analysis Wizard to Fit the Data 

 

Now that the Project file has been created we can use the Analysis Wizard to fit the 

data. 
 

For this Workflow example we will be performing an Association analysis using the 

Monophasic Integrated Rate Equation. 
 

a.) To launch the Analysis Wizard, select the Analysis Wizard item from the 

Activity Bar as shown in the figure below. 
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Figure 3.14 - Selecting the Analysis Wizard 

 

b.) The Analysis Wizard is a step-by-step process that assists the user in analyzing 

data. The figure below gives a picture of Step 1 which is displayed when the 

wizard is opened. Selected the Association option and click Next. 
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Figure 3.15 - Analysis Wizard 

 

c.) Step 2 of 7 - In this step the concentration for each of the measurements is 

entered. The screenshot below shows the values that are to be entered. Fill out 

the concentrations and click Next. Refer to Section 6 for a discussion of using 

Calibration Files to set the concentrations. 

 

 
 

Figure 3.16 - The Concentrations for the Measurements 
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d.) Step 3 of 7 – Selecting the Analysis Region. For this analysis all plots are 

going to use the same start and end times. Ensure that the Same Region for all 

Plots option if selected. Now select any one of the start times with a single-

click and then select the Line tool as shown in the figure below. 

 

 
 

Figure 3.17 – Select the Line Tool to Specify the Region 

 

With the Line Tool selected, mouse over the graph to guide the line to the 

desired start point and then right-click to set the start time. The screenshot 

below illustrates the start time selection. Changes made via the Line Tool are 

reflected in the table, and vice-versa. The start and end times are shown with 

diamond arrows on the analysis curves. 

 

Once the start point has been selected (the default end point can be used for 

this example) click the Next button. 

 

 

 
Figure 3.18 – Using the Line Tool to Select the Start Point 

 

e.) Step 4 of 7 – The graph will now show only the region that was selected in the 

previous step (see Figure 3.19). This example will be using the Integrated 

Rate Equation method. Make sure that this option is selected and click Next. 
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Figure 3.19 – The Graph now shows only the selected region 
 

f.) Step 5 of 7 – This example will be using the Monophasic Integrated Rate 

Equation. Ensure that this method is selected, as shown in the figure below, 

and click Next. 

 

 
 

Figure 3.20 – Selecting the Monophasic Model 

 

g.) Step 6 of 7 – In this step of the Analysis Wizard the fitting of the model to the 

experimental data will take place. 

 

It is strongly suggested that the initial fitting parameters be tested before 

starting the fit procedure. To test the parameters, press the Test button as 

shown in the figure below 
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Figure 3.21 – Testing the Initial Fit Parameters 

 

The initial fit parameters are acceptable if the model plots (green lines) are of 

the same order of magnitude as the experimental data. Figure 3.22 shows the 

initial fit plot for this example (which is acceptable). 

 

 
Figure 3.22 – Initial Plot of the Fit Parameters 

 

Once the initial fit parameters have been tested, the fitting of the data can be 

performed by clicking the Run button. 

 

During the fitting procedure the plot that is currently being fit will be shown in 

the tab on the left of the screen. The green model lines for the plots will be 
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redrawn upon each iteration of the fitting routine that improves the Chi
2
 of the 

fit. Figure 3.23 depicts the fitting of Plot#2. A more detailed overview of the 

fitting procedure can be found in section 5.3. 

 

Once the fit procedure has ended, click Next to proceed to the summary. 
 

 
 

Figure 3.23 – Running the Fitting Procedure 
 

h.) Step 7 of 7 – The final step of the Analysis Wizard is the summary of the 

performed fit. The summary, as shown in the figure below, shows the general 

configurations that were used and the final parameter values for each plot. 

 

This data can be copied to the clipboard by clicking the Copy to Clipboard 

button. 
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Figure 3.24 – Summary of the Fit 
 

i.) The Analysis Wizard is now complete. Press the Finish button to add this 

analysis to the project. 

 

j.) The analysis will be added to the Project and will be displayed in the user 

interface. Notice that in the Project navigation bar (see left side of the figure 

below) the Analysis has been added. To display the Overlay plot again right-

click on the Overlay name. 

  



30  Autolab SPR - KE User manual 

  

 

 

 
Figure 3.25 – Analysis has been added to the Project 

 

This concludes the KE workflow demonstration. The remaining sections in the 

manual will go into more detail about everything that was performed in this example. 
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4 – Working with Data 

 

This section of the manual provides an overview of the different file types that the KE 

application supports. 

 

4.1 – Opening Files 

 

There are three methods to open file in KE. The following subsections give an 

example of each. 

 

4.1.1 – Opening a File from the Main Menu 

 

From the Main Menu, Measurement, Overlay, Project and Calibration files can be 

opened. Figure 4.1 shows the menu items. 

 

 
 

Figure 4.1 - Opening a Measurement file from the Main Menu 

4.1.2 – Opening a File from the Toolbar 

 

Files can be opened from the Toolbar by clicking the open icon as shown in Figure 

4.2. 

 

 
 

Figure 4.2 - Opening a File from the Toolbar 
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Different types of files can be opened (Measurement, Overlay, Project and 

Calibration files). Upon clicking the open icon in the Toolbar, a selection for what 

type of file to open will be made (as shown in Figure 4.3). 

 

 
 

Figure 4.3 - Opening an Overlay file from the Toolbar 

 

4.1.3 – Opening a File from the Activity Bar 

 

The third method to open data files in KE is to click on the file type in the Activity 

Bar. 

 

Figure 4.4 depicts the action of opening a Project file. 
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Figure 4.4 - Opening a Project file from the Activity Bar 

 

4.2 – Viewing Files 

 

The KE application allows the user to view all files (Measurement, Overlay, Project 

and Calibration) using three different views. 

 

Changing the current view for a file can be performed via the Main Menu (see Figure 

4.5) or by clicking on the desired view from the Activity Bar as shown in Figure 4.6. 

 

 
 

Figure 4.5 - Changing the View Mode via the Main Menu 
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Figure 4.6 - Changing the View Mode via the Activity Bar 

 

The following subsections give an overview of each of the views 

 

4.2.1 – Interaction Plot View 

 

The Interaction Plot View is the data plotted in a graph. This view is the default view 

for all file types. 

 

Measurement files have the option to show/hide the various plots that they contain. 

This functionality is available via the Main Menu and is shown in Figure 4.7. By 

default, all components of a Measurement file are displayed (Channel 1, Channel 2, 

and Temperature or Differential data on the second Y Axis). 
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Figure 4.7 - Setting the visibility of the Measurement Plots
*
 

 

4.2.2 – Data Point View 

 

The Data Point View displays the data points of the plots in a grid.  
 

Figure 4.8 shows the Data Point View of an Overlay file. 
 

 

 
Figure 4.8 - Viewing the data points of an overlay file 

                                                 
*
 For users of the Autolab SPR - Springle software the Channel 2 and Differential plots are not 

available. 
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It is possible to copy this data to another application via the clipboard. To copy the 

data, follow the steps below. 
 

a.) Click on the columns that you wish to copy (or click the square in the top-left 

corner to select all the data, as shown in Figure 4.9).  

 

 

 
Figure 4.9 - Selecting all the data points 

 

b.) Press CTRL-C on the keyboard to copy the data 

 

c.) Open the application that you wish to copy the data to (Microsoft Excel is 

being used for this example). 

 

d.) Press CTRL-V on the keyboard or click FileEditPaste from Excel’s 

Main Menu. 

 

e.) The data points from Kinetic Evaluation will now be copied into Excel as 

shown in the figure below. 
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Figure 4.10 - Overlay data copied in a Microsoft Excel worksheet 

 

4.2.3 – Event Log / History / Summary View 

 

The different file types in Kinetic Evaluation contain different details that can be 

displayed. 

 

Event Log – Measurement Files 

 

The Event Log, in Measurement files, is generated during the collection of data the 

Autolab SPR - Data Acquisition software. This data is read-only in the KE 

application. If the measurement file does not contain Event Log information then the 

grid will be empty. 

 

The following screenshot shows the Event Log for a measurement. 
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Figure 4.11 - Measurement Event Log 

 

History – Overlay Files 

 

Overlay files keep an internal history of the changes made to the file. These logged 

items can be displayed by viewing the History of the overlay file, as shown in the 

figure below. 
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Figure 4.12 - History items of an Overlay file 

 

The history log keeps track of what files were used to construct the Overlay file and 

what (if any) actions were taken on the data with the Signal Processing Tool (see 

section 5.2). 

 

It is possible to copy this data to another application by clicking the Copy to 

Clipboard button. 

 

Summary View – Analysis Files 
 

When an analysis is performed using the Analysis Wizard (see section 5.3) an 

analysis is added to the project file. By changing the view of the analysis to Summary, 

it is possible to view the results of the fitting. The fitting results can also be copied to 

another application by clicking the Copy to Clipboard button. 

 

Figure 4.13 shows the summary view for an Association analysis. 
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Figure 4.13 – Summary View of an Analysis 
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4.3 – Measurement Files 

 

Measurement files are generated using the Autolab SPR – Data Acquisition 

application. KE also provides support for measurement files of different formats 

KE supports the following file types of measurement files: 

 
Table 4.1 – Supported Measurement Files 

 

File Type File 

Extension 

Description 

SPR file .spr DA measurement file (version 4.2) 

KE Sub Curve file .ksc Partial measurement made by KE (version 5.0 

or greater) 

Data file .ibo Legacy DA measurement file (versions older 

than 4.2) 

Text file .txt Exported data from Biacore or CLAMP  

Within the KE application measurement files are treated as read-only files. It is not 

possible to change the contents of a measurement file within the KE application. 

 

4.3.1 – Opening a Measurement File with Multiple Plots 

 

Measurement files that are generated by other applications (i.e. Biacore or CLAMP) 

may contain more than one measurement per file. If a text file is opened that contains 

more than one measurement it is up the user to decide how KE will handle the 

measurements. In Figure 4.14 below the user is given the option to open the 

measurements as separate files (i.e. 1 file per measurement) or to directly build a new 

Overlay (see section 4.4) from the measurements in the file. 

 

 
 

Figure 4.14 - Multiple Measurements User Prompt 

 

 

 

4.3.2 – Creating Sub Curves from a Measurement 
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It is possible to select a section of a measurement and copy it into a new file. This 

type of file is called a KE Sub Curve. 

 

The following steps show how to create a KE Sub Curve file 
 

a) Open a measurement file 
 

b) Change the graph mode Selection, as shown in Figure 4.15. 
 

 
 

Figure 4.15 - Changing the Graph Mode to Select 
 

c) Right-Click and drag the mouse pointer to select the region that you want to 

copy into a new measurement file (see Figure 4.16). 

 

 

 
Figure 4.16 - Selected data to be copied to a sub curve 

 

d) Once the selection has been made, Click the New Subcurve item in the 

Activity Bar as shown in Figure 4.17. 
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Figure 4.17 - Choosing the sub curve option 

 

e) A new file will be created which contains the selected data. Figure 4.18 shows 

the new KE Sub Curve file. 

 

 

 
Figure 4.18 - The newly created Sub Curve 

 

4.4 – Overlay Files 

 

Overlay files are the result of combing multiple interaction plots (Measurement files) 

into one file. 
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Overlays are built with the Overlay Builder, which is depicted in Figure 4.19. The 

Overlay Builder can be opened from the Main menu (FileNewOverlay…) or by 

clicking on the New Overlay item in the Activity Bar. 

 

 
 

Figure 4.19 - The Overlay Builder
†
 

 

To create a new overlay select the interaction plots (by checking the boxes) that you 

wish to add. Items that are present in the measurement are presented with a green 

background while items with gray background indicate interactions that were not 

located in the measurement. To select all available interaction plots, you can click the 

“Check All” button. 

 

Once the interaction plots have been selected, press the OK button to create the new 

Overlay. Figure 4.20 shows the results of the selections made in Figure 4.19. 
 

                                                 
†
 For users of the Springle software the Channel 2 and Differential columns are not 

available. 

Note 

In order to create a new an Overlay file there must be at least one 

Measurement file opened. 
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Figure 4.20 - The new overlay file 
 

The new Overlay file can be saved to disk by clicking FileSave, or click the save 

icon  in the Toolbar.  

 

In general, any files that are opened in KE that contain unsaved data will appear with 

a “*” at the end of their name (i.e. the new Overlay name is Overlay.kod*). 

 

4.4.1 – Overlay Manager 

 

Once an overlay is created, it is possible to add or remove measurements from the 

overlay before it is saved. Clicking on the Manage Overlay button on the Toolbar, or 

Tools  Manage Overlays, to the launch the Manage Overlay Dialog. 
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Figure 4.21 – Overlay Manager dialog before the Overlay is saved 
 

The check boxes will allow the user to add or remove measurements from the overlay.  

 

 
 

Once the overlay is saved, each measurement is saved as a single element in the 

overlay. Figure 4.22 shows the Manage Overlay dialog after loading and overlay from 

disk. 

 
 

Figure 4.22 – Overlay Manger dialog after the Overlay is saved 

Note 

It is possible to change plot names in the Overlay Manager by Double-

clicking on a plot name. 
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4.5 – Project Files 

 

Project files are a new concept since KE version 5.0. The purpose of a project file is to 

store all analyses that were performed on an Overlay into one file. 

 

4.5.1 – Creating a Project File 

 

To create a new Project file, click FileNewProject… or click on New Project in 

the Activity Bar. The following dialog (Figure 4.21) will be shown to assist the user 

in selecting how to create the new overlay. 

 

 
 

Figure 4.23 - Options to Create a new Project 
 

If there are Overlay files opened in KE, they can be selected in the combo box and 

imported into the new Project. If there are no Overlay files opened then it is possible 

to import an Overlay file from disk. 

 

Van’t Hoff Projects are a special form of projects that support temperature based 

analyses. These projects are discussed in section 7. 

 

Upon clicking the OK button on the Project Builder dialog, a new project file is 

displayed, as shown in the Figure 4.24. 
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Figure 4.24 - The new project file 

 

When a new Project is created, the Project Navigation Bar (see section 2.5) is 

displayed on the left-hand side of the screen. This navigation bar tool is required 

because Project files can contain multiple sets of data. 

 

4.5.2 – Performing an Analysis 

 

Analysis files are created by the Analysis Wizard which is described in section 5.3. 

Analysis files are a part of a Project file and cannot be saved separately. The 

reasoning for this restriction is to guarantee that the analysis is always sorted with the 

Overlay file (also stored in the Project file) was used for the analysis. 

 

The result running the Analysis Wizard is that a new analysis will be added to the 

project. The project now handles three different types of analysis – Association, 

Equilibrium and Dissociation analysis. 

 

4.5.3 – Navigation of a Project File 

 

Project files contain one Overlay file and analysis files. It is possible to view the 

different components of the Project file by clicking on them in the Project Navigation 

Bar. Figure 4.25 shows the Project Navigation Bar in which an analysis named 

Associaton1 is selected. 
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Figure 4.25 - Changing the Visible Plot 
 

4.5.4 – Types of Project Files 

 

In KE 5.1, there now exists three types of project file. The preceding section has 

discussed a default project file. One can also create Calibration projects and Van’t 

Hoff projects. The differences in these project types are detailed in Table  

 
Table 2.1 – Overview of the File Menu Items 

 

Project Types Purpose Allowed 

Analyses 

Number of 

Overlay Files 

Additional 

Project Data analysis Association 

Dissociation 

Equilibrium 

One Overlay File 

only 

Section 5.3 

Calibration Calibration Equilibrium One Overlay File 

only 

Section 6 

Van’t Hoff Temperature 

based 

analysis 

Van’t Hoff Multiple overlays 

allowed 

Section 7 

 

4.6 – Changing Chart Properties 

 

It is possible to change to look of the graph for Overlay and Project files. By clicking 

ViewChart Properties or the Properties button in the Toolbar will launch the 

Chart Properties dialog as shown in Figure 4.26 below. 

 

 
 

Note 

It is not possible to change the plot properties of a Measurement file. The KE 

application handles Measurement files as Read-Only documents. 



50  Autolab SPR - KE User manual 

  

 

 
 

Figure 4.26 - Chart Properties Dialog 

 

The first tab in the Chart Properties dialog is Plots. To change one of the plots in the 

graph, click on its name from the list of plots. 

 

 
 

 

The Line Pattern, Size and Color can be changed by using the dropdown lists on this 

dialog. 

 

It is also possible to display Symbols on the data points in the plot by selecting a 

Symbol Pattern (by default, Symbol Pattern is set to none). 

 
 

The next tab in the Chart Properties dialog is for the Chart itself. As shown in Figure 

4.27, the Title, Vertical & Horizontal Axis can be configured here.  
 

Note 

It is possible to edit the properties of multiple plots at once.  Select multiple 

plots by holding down the SHIFT button while clicking on the plot names. 
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Figure 4.27 - Chart Properties 

 

The last tab in the Chart Properties dialog (see Figure 4.28) contains the configurable 

items that are global (the same) for all opened files. 

 

The Border and Background colors can be changed while the Vertical and Horizontal 

gridlines can be shown or hidden. 

 

 
 

Figure 4.28 - Global Properties 
 

 

 

4.7 – Printing Data 

 

In KE it is possible to print the graphs and the files details of the graphs. 
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To print a file, click the FilePrint menu item and Figure 4.29, will be displayed. 
 

 
 

Figure 4.29 - Print Dialog 
 

From this dialog it is possible to configure the items that are to be printed. Figure 

4.29, depicts a project file with all of its graphs to be printed. To print file details click 

the appropriate check box in the Details column. 
 

The Page Margins and Page Orientation can be also configured from within this 

dialog. It is also possible to preview a file by clicking FilePrint Preview in the 

main menu. Figure 4.30 shows the print preview of an Overlay file. 
 

 
 

Figure 4.30 - Print Preview Dialog 
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5 – Analyzing the Data 

 

This section of the manual provides an overview of the different features that are 

available in the KE application to analyze data. 

 

5.1 – Modeling Wizard 

 

The Modeling Wizard is used to construct Rate Equations that are used by the 

Numerical Integration method in the Analysis Wizard (see section 5.3). 

 

The process to construct a rate equation is performed in five steps. The following 

subsections go over each step in detail. 

 

5.1.1 – Starting the Modeling Wizard 

 

The Modeling Wizard can be opened from the Main Menu (section 2.2) 

ToolsModeling Wizard or from the Activity Bar (section 2.4) Modeling Wizard. 

 

Upon opening the Modeling Wizard the dialog in Figure 5.1 will be displayed. 

 

 
 

Figure 5.1 – Creating a model 

 

In Step 1 of the Modelling Wizard there are two options to choose from, Create a new 

kinetic model or Open Existing Model from disk. 

Select the Create New Kinetic Model and click Next. 

5.1.2 – Configuring the Modeling Information 
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Step 2 of the Modeling Wizard is shown in Figure 5.2. In this step the information 

about the model is entered. Every model is given a name and an optional description. 

 

 
 

Figure 5.2 – Model Information Step 
 

To give the model a name, click the text Click to add a model name. To add a 

description to the model, click in the Model Description text box and enter the text. 

 

 

Figure 5.3 shows an example of a model name and description entered. 

Add your model name and description and click Next. 

 

 
 

Figure 5.3 – Information for the Model 



Autolab SPR – KE User manual  55 

  

 

5.1.3 – Defining the Species 

 

In Step 3 of the Modeling Wizard the species that are used in the rate equations will 

be defined. 

 

Enter in each unique species for the rate equation, as shown in  

 

Figure 5.4. Once you have entered in your species click the Next button to proceed. 

 

 
 

Figure 5.4 – Defining the Species 

 

 

Define Species Only Once 

 

If the rate equation for the model is made up of multiple equations, for 

example: 
 

 
 

Define each species once even though they may be used in several equations 

(A in the rate equation above is the product of the 1
st
 rate equation and is the 

analyte in the second part of the rate equation. 
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5.1.4 – Creating the Rate Equations 

 

In step 4 of the Modeling Wizard it is time to construct the rate equation. Use the 

dropdown controls on the dialog, as shown in Figure 5.5, to configure the species for 

the rate equation. 

 

 
 

Figure 5.5 – Creating a rate equation 

 

Once the Analyte, Ligand and Product have been defined, click the Add button to add 

the rate equation to the model.  

 

 
 

Figure 5.6 shows that the model has one rate equation defined for it. If you wish to 

remove a rate equation from the model then select the equation from the defined 

equations (click on it to highlight it) and press the Delete button. 

 

Once you have configured your rate equation, click Next to proceed to the next step. 

 

Note 
 

A valid rate equation must consist of at least an Analyte and a Product. 
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Figure 5.6 – Completed rate equation 

 

5.1.5 – Summary of the Model 

 

The last step of the Modeling Wizard is the summary of the completed model. To 

make changes to the model click the Back button to return to the step that requires 

changing. 

 

Figure 5.7 shows the summary for the Monophasic model that was constructed in this 

example. 

 

 
 

Figure 5.7 – Summary of the newly created model 
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To end the modeling wizard, click the Finish button. Before the wizard closes the 

user will be prompted to save the model. 

5.1.6 – Editing an Existing Model 

 

To edit a previously saved model, start the Modeling Wizard and select the Open 

Existing Model option in the first step of the wizard (as shown in Figure 5.8). The 

selected model will be loaded into the wizard and all the model information will be 

automatically entered into the wizard. 

 

 
 

Figure 5.8 – Opening a Model from Disk 

 

5.1.7 – Advanced Settings 

 

Certain models can have more than one product that contributes to the SPR signal. For 

example, in the set of equations that describe a conformal change reaction, 

 

 
 

both AB and AB* can contribute to the SPR signal. To indicate to the model that both 

AB and AB* are final products, click on the “Advanced” button in step 4 as shown in 

Figure 5.9. 
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Figure 5.9 – Advanced model configuration 

 

Clicking the “Advanced” button will show an additional dialog where the signal 

weights can be entered. In Figure 5.10, the signal weights for AB and AB* are set to 

be equal, so that each of AB and AB* contribute the same to the SPR signal in the 

model. 

 

 
 

Figure 5.10 – Setting the signal weights 

5.2 – Signal Processing 

 

It is possible to improve data quality in the KE application by using the Signal 

Processing tool. Signal processing can be performed on Overlay files only. Overlays 

that are a separate file (*.kod) or part of a Project file (*.kpf) can be used in the Signal 

Processing tool. 

 

The Signal Processing dialog can either be opened by clicking from the Main Menu 

ToolsSignal Processing or clicking on the Signal Processing item in the Activity 

Bar as shown in Figure 5.11. 
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Figure 5.11 – Selecting Signal Processing 

 

Once the Signal Processing dialog has been opened it will appear as shown in Figure 

5.12. 

 

 
 

Figure 5.12 – Signal Processing Dialog 

 

The following descriptions correspond to the numbers that appear in Figure 5.12. 

 

1. Actions – Select which signal processing technique to perform on the data. 

The following subsections will explain each of the available actions. 

 

2. Apply To – This section is used to specify which interaction plots are to be 

included in the signal processing technique and how the technique will be 

applied. There are two options for how the technique will be applied, it can 

process the entire plot or only a portion of the plot that is selected via the 

Select mode (click the Select button and with the right mouse button down 

drag the mouse to select a region). 

 

3. Apply/Undo – Once the technique and the plots that will be processed have 

been configured, press the Apply button to run the action. If the action did not 
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perform the desired effect then this action can be undone by pressing the Undo 

button. There is no limit to the amount of times an action can be applied. 

 

4. Overlay Data – The overlay data is updated upon each press to the Apply 

button. All signal processing changes can be viewed in this graph. 

 

5. Graph Toolbar – The figure below depicts the tools that are available for the 

Signal Processing dialog. 

 

 
 

Figure 5.13 – Signal Processing Toolbar 

 

The Toolbar contains the following items: 

 
Table 5.1 – Toolbar Items 

 

Toolbar Item  Description 

Legend - Show/Hide the legend for the Overlay  

Pointer - This is the default mode of the graph 

Zoom - Left-click and dragging the mouse pointer on the graph 

will zoom in on the selected region 

Select - Left-click and dragging the mouse pointer will select a 

region for the signal processing action to process 

 

The following subsections will give an overview of each of the Signal Processing 

techniques. 

 

5.2.1 – Blank Subtraction 

 

The Blank Subtraction action subtracts the selected plot from the other plots that are 

selected in the Apply To section of the Signal Processing dialog. Blank Subtraction 

can execute on a selected region or the full plot. 

 

To use the Blank Section action, select the plot that you wish to use as the blank (as 

shown in Figure 5.14). This plot will then be subtracted from the other selected plots. 

 

 
 

Figure 5.14 – Blank Subtraction Options 
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The following screenshots show the effect of using the Blank Subtraction action. The 

effect of the blank subtraction is can be seen in Figure 5.16 as the Response intensity 

has been reduced. 

 

 
 

Figure 5.15 – Overlay before Blank Subtraction 
 

 
 

Figure 5.16 – Response Intensity is reduced after Blank Subtraction 

 

5.2.2 – Delete Selection 

 

The Delete Selection action deletes the selected region of the plot. This action is 

available only for a selected region and cannot be used with the Full Plot option. 
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The selected region of the plot is removed while any plot information before and after 

the deleted region is retained. The data that remains after the deleted region is moved 

to the end of the plot that is still remaining before the deleted region. 

 

The following two figures are before and after screenshots of the Delete Section 

action. 
 

 
 

Figure 5.17 – Select a Region to be Deleted 

 

 
 

Figure 5.18 – Result of the Delete Selection Action 
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5.2.3 – Fast Fourier Transform (FFT) 
 

The Fast Fourier Transform (FFT) action is a filtering technique used to reduce high 

frequency interference in the plots. This action can be applied to a selected region or 

to the full plot(s). 
 

The Figure 5.19 shows plots that contain high frequency noise. 
 

 
 

Figure 5.19 – Noisy Data 
 

To improve the quality of the plots, select the Fast Fourier Transform action and click 

the Apply button. 

There is an intermediate step in the FFT action. The user must select the region of the 

frequency plot they wish to retain for each plot that is being filtered. In the frequency 

plot the data at the lower frequency is what is to be retained. Select the area of the 

graph that contains intensity above the baseline. Figure 5.20 depicts this selection. 
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Figure 5.20 – Region of the spectrum to retain 

After selecting the region to retain for each plot the filtered plots will be presented as 

shown in Figure 5.21. 
 

 
 

Figure 5.21 – Result of the Fast Fourier Transform 

 

5.2.4 – Mathematical Operation 
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The Mathematical Operation action performs the operation that is selected by the user 

on the selected plot(s). The available operations, as shown in the figure below, are 

Addition, Division, Multiplication and Subtraction. 

 

To use this action, select the operation that you wish to perform and enter in the Value 

to assign to this action. Next select the plots that this action will be applied to and 

select the region of the plot(s) that will be affected (it is also possible to use the Full 

Plot option). 

 

 
 

Figure 5.22 – Mathematical Operation Options 

 

Figure 5.23 and Figure 5.24 shows the result of multiplying one of the plots in the 

Overlay by three. 

 

 
 

Figure 5.23 – Overlay before the Mathematical Operation is applied 

 



Autolab SPR – KE User manual  67 

  

 

 
 

Figure 5.24 – Multiplication of a Plot by Three 

 

5.2.5  – Normalize 

 

The Normalize action subtracts the offset of the first Response data point (y axis) 

from the rest of the plot. This technique is useful to quickly remove an offset from the 

data. This action is only available to the Full Plot. 

 

Figure 5.25 and Figure 5.26 show the effect of executing the Normalize action. 

 

 
 

Figure 5.25 – Overlay before Normalize Action 
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Figure 5.26 – Overlay after Normalize Action 

 

5.2.6 – Smooth 

 

The Smooth action performs a Savitzky-Golay smoothing filter on the selected data. 

This action can be executed on the full plot or the selected region within the plot(s). 

 

To perform the Smooth action select Smooth from the list of actions, as shown in 

Figure 5.27. The polynomial used in the filter is set by the user, either 2
nd

 or 4
th

 order 

(default: 2
nd

 Order). 

 

The number of points in the smoothing window is defined by the equation 2(m+1) 

where the value of m is determined by the user via the Value dropdown list (see 

Figure 5.27). 

 

 
 

Figure 5.27 – Smooth Options 

 

The screenshot Figure 5.28 is before and Figure 5.29 is after the Smooth action. 
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Figure 5.28 – Overlay before Smoothing 

 

 
 

Figure 5.29 – Result of the Smooth Action 

 

5.2.7 – Synchronize 

 

The Synchronize action removes the selected region between plots so a common 

starting time can be achieved. 

 

Typical data in which this action should be applied is shown in Figure 5.30. Notice 

that the starting times of the association regions do not start at the same time point. 
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Figure 5.30 – Association Regions starting at Different Times 

 

To synchronize the starting times, Zoom in on the starting points of the plots and use 

the Select tool (in the Signal Processing Toolbar) to select the region to synchronize. 

Figure 5.31 depicts this selection. 

 

 
 

Figure 5.31 – Selecting the Region to Synchronize 

 

Ensure that the Synchronize action is selected and the plot to be synchronized is 

selected in the list of plots. 
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The following figure depicts the result of the synchronization. 

 

 
 

Figure 5.32 – Result of the Synchronize action 

 

5.2.8 – Zero at Average 

 

The Zero at Average action averages the value of the data in the selected region and 

subtracts this value from the entire plot. The user must select a region before using 

this action as the Full Plot option is not possible. 
 

The following Figure 5.33 and Figure 5.34 are before and after screenshots of the 

Zero at Average action. Note that the plots have been zoomed into a region to clearly 

demonstrate the action. 
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Figure 5.33 – Zoomed in and Selected Region to Zero 

 

 
 

Figure 5.34 – Result of the Zero at Average action 
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5.3 – Analysis Wizard 

 

The Analysis Wizard is used to determine the kinetic binding rates of the interaction 

plots that are measured with the Autolab SPR Data Acquisition software. 

 

This section gives an overview of the features of the Analysis Wizard. A step-by-step 

example of how to use this wizard is given in the Getting Started with the KE 

Workflow section of the manual (section 3.5). 

 

The Analysis Wizard can only be opened when a Project file (section 4.5) is created 

or a saved Project file is opened from disk. 

 

To launch the Analysis Wizard click ToolsAnalysis Wizard from the Main Menu 

or click on the Analysis Wizard item in the Activity Bar as shown in Figure 5.35. 
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Figure 5.35 – Launching the Analysis Wizard from the Activity Bar 

 

The screenshot below (Figure 5.36) depicts the first step that is shown when the 

Analysis Wizard is opened. 
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Figure 5.36 – The Analysis Wizard 

 

The following descriptions correspond to the numbers that appear in Figure 5.36. 
 

1. Action Area – This region of the Analysis Wizard is where all the user 

options and configurations take place. Each step in the wizard will 

present a new panel. 

 

2. Overlay Data – The Analysis Wizard uses the Overlay data from a 

Project file. This graph will display the Overlay plots and eventually 

will show only the region of the plots that is selected by the user to 

analyze (section 5.3.3). 

 

3. Graph Toolbar – The figure below depicts the tools that are available 

for the Analysis Wizard dialog. The Plots toolbar option is not 

available until the end of the Analysis Wizard process (see section 

5.3.7). 

 

 
 

Figure 5.37 – Analysis Wizard Toolbar 

 

4. Navigation Buttons – To move step-by-step through the Analysis 

Wizard use the Next button. To move to a previous step in the wizard 
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use the Back button. To quit the wizard at anytime use the Cancel 

button. 

 

The following subsections provide a detailed overview of each step in the Analysis 

Wizard. 
 

5.3.1 – Selecting the Region to Analyze 

 

The first step in the Analysis Wizard is to specify which type of analysis is to be 

preformed. Figure 5.38 shows the first step of the wizard. 

 

The available analysis options are: 

 

 Association – Region in the Overlay where the analyte (injected sample) 

combines with the immobilized ligand (sample on the gold disk) to form a 

complex. This is the region in the graph that has a positive slope. 

 

 Equilibrium – Region in the Overlay when there are no more ligand locations 

remaining for the analyte bind with. This is the region in the graph where the 

slope of the line approaches zero. 

 

 Dissociation – Region in the Overlay where the analyte is removed from the 

immobilized ligand. This region of the graph has a negative slope. 

 

 Determine Concentrations – The concentrations of an overlay can be set 

from a previously calculated Calibration curve (See Section 6 for creating 

Calibration curves). Section 5.3.13 details how to apply a calibration curve to 

an overlay to determine the concentrations. 
 

 
 

Figure 5.38 – Select the Region to analyze 
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5.3.2 – Specify the Concentrations 

 

The second step of the Analysis Wizard is to specify the concentrations of the 

interaction plots. 

 

As shown in Figure 5.39, the concentration value is entered and the unit of the 

concentration is specified. 

 

 
 

Note 

Equilibrium Analysis contains different steps in the Analysis Wizard. The 

Equilibrium Analysis process is described in the following sections: 

a.) 5.3.8 

b.) 5.3.9 

c.) 5.3.10 

d.) 5.3.11 

e.) 5.3.12 

Determine Concentrations contains different steps in the Analysis Wizard. 

These steps are described in the following sections:  

a.) 5.3.13 

b.) 5.3.14 

c.) 5.3.15 

d.) 5.3.16 

  

Note 
 

If the concentration of the interaction plot is for example 100 nM then enter in 

100 and select the nM units. Do not enter 100e-9 unless the M unit is selected. 
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Figure 5.39 –Specifying the Concentrations 

 

It is possible that the concentrations were already supplied before running the 

Analysis Wizard. One such method to determine the concentrations is to run the 

Analysis Wizard and select “Determine Concentrations” from a Calibration curve. 

This process is detailed in section 5.3.13. 

 

If the concentrations were determined from a Calibration curve, the user will get a 

warning. 

 

 
 

Figure 5.40 -- Equilibrium concentration warning 

 

Because the concentrations were determined from a Calibration curve, and the 

calibration curve uses an equilibrium analysis (see section 6.1), running the 

equilibrium analysis will simply return the same analysis from the calibration 

analysis. 

5.3.3 – Specifying the Start/End Times of the Analysis 

 

The next step in the Analysis Wizard is to specify the start and end times for the type 

of analysis region that was selected. 

 

In general the following guidelines should be followed when selecting the start/end 

times: 
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 Association – The start time is the start of the positive sloped curve while the 

end time is where the slope levels off towards zero. 

 

 Equilibrium – Use the same starting point as Association and the end time will 

be the time right before the slope changes to a negative value (this is the start 

of Dissociation). 

 

 Dissociation – The start value is the start of the region with a negative slope 

while the end region is where the slope levels off to zero. 

 

To select the start and end times the following instruction dialog will be presented to 

the user. 

 

 
 

Figure 5.41 –Instructions for Selecting Start/End Times 

 

This dialog (Figure 5.41) explains that there are two methods of setting the analysis 

times. If you don’t require this message it can be removed from the wizard by clicking 

the Don’t show this dialog again checkbox and clicking OK. 

 

The first method is to manually enter the times. To enter a value, double-click the 

desired cell and enter in the time. Figure 5.42 shows the end time for KIN101 Channel 

1 being manually entered. 

 

There are two Region Options to select on the dialog. The default, Same Region for 

All Plots, will copy your entered time to all interaction plots. The Unique Regions 

for Each Plot will allow the user to enter custom start/end times for each plot. 
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Figure 5.42 – Changing the End Point Manually 

 

The second method to change the analysis times is to use the graph’s Line Tool to 

visually set the times. 

 

The steps to use this method are: 

 

 Click (single click) on the time that you wish to change 

 Click on the graph Line Tool (Line button in the toolbar) to activate it. 

 Drag the mouse pointer over the graph to select the desired time 

 Click (single click) to set the time 

 

Figure 5.43 highlights the items that are used in this method.  
 

 
 

Figure 5.43 – Using the Line Tool to Select the Start Time 
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It is possible to obtain additional information about the association starting point of 

the curve. Selecting Unique Regions for Each Plot and Show ln(dR/dt) vs. t will 

overlay the logarithm of the derivative versus time, and can be useful to see mass 

transport effects. This option is only available when unique regions are used for each 

plot. The user has to set each starting and ending point for each plot. The overlay of 

the derivative curve is shown in Figure 5.44. 

 

 
 

Figure 5.44 – Showing the derivative of the curve to aid in setting the Start Time 

 

5.3.4 – Selecting the Analysis Method 

 

The next step in the Analysis Wizard is to select the method that will be used for the 

fitting of the data. Figure 5.45 depicts a screenshot of this step. 

 

 

 
 

The current Kinetic Evaluation application provides two analysis methods: 

 

Integrated Rate Equation – These equations are pre-integrated before they are used 

in the fitting routine. Due to this pre-integration step this model cannot handle 

complex rate equations. The available integrated rate equations are Monophasic and 

Biphasic. It is not possible for the user to create custom integrated rate equations. 

 

Note 

This Analysis Wizard step is not required for Equilibrium Analysis. 

For Equilibrium Analysis, skip to section 5.3.8. 
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Numerical Modelling – This is a more complex method in which the rate equations 

are integrated numerically during the fitting process. The benefit of having the rate 

equation numerically integrated is that more complex models can be used. It is 

possible for users to construct rate equations to use with the Numerical Modelling 

method (see section 5.1 for more details). 

 

 
 

Figure 5.45 – Selecting an Analysis Method 

 

5.3.5 – Selecting the Model to Use 

 

The next step in the Analysis Wizard is to specify which model to use. This step 

differs depending on which analysis method was selected in previous step (see section 

5.3.4). 

 

Figure 5.46 is a screenshot of the models that are available for the Integrated Rate 

Equation method. The model is specified by selecting it from the drop-down list. A 

brief description is displayed for the currently selected model. 

 

 
 

Figure 5.46 – Selecting the Integrated Rate Equation 

 

If you have selected Dissociation analysis, a third model option will appear, 

Rebinding Monophasic, as shown in Figure 5.47. This is a monophasic model that 

incorporates terms related to rebinding
*
. 

                                                 
*
 See, for example, Schuck and Minton, “Analysis of Mass Transport-Limited Binding Kinetics in 

Evanescent Wave Biosensors” Analytical Biochemistry 240, 262–272 (1996) 
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For the fit to the monophasic rebinding model to converge, it is necessary for the user 

to supply some input parameters, Bmax and KA/Ktr (see the Schuck and Minton paper 

for definitions). Bmax can be determined from an equilibrium analysis, and if 

equilibrium analyses have been performed, it can be imported from an opened 

equilibrium analysis by using the combo selection box. The box is not shown if 

equilibrium analyses have not been performed. KA/Ktr is typically a small number << 

1. 

 
 

Figure 5.47 – Selecting the Integrated Rate Equation 

 

Selecting a model for the Numerical Analysis method is similar to the previous 

process except the user can also load a custom model from disk. 

 

The models in the drop-down list, as shown in Figure 5.48, are the models that are 

located in the Autolab SPR Models folder (..\Autolab SPR\Models). When a model 

is selected the model is displayed and the description of the model is shown. 
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Figure 5.48 – Selecting the Numerical Analysis Method 

 

To select a custom model use the Browse button to select a Kinetic Model 

Description file (*.kmd). 

 

If the selected model does not already exist in the standard modelling folder then a 

prompt will be given to copy the selected model. Figure 5.49 shows this user prompt. 

 

 
 

Figure 5.49 – Prompt to Copy a Model to the Default Model Folder 

 

5.3.6 – Configuring and Fitting the Model 

 

The next step in the Analysis Wizard is the configuration of the fitting parameters. 

 

On first open of this step the information dialog, shown below, will be shown to 

explain that for best results use the Test button to ensure that the initial parameters are 

in range of the experimental data. In range means the model plots should be in the 

same order of magnitude as the experimental data. 

If you do not wish to see the information dialog the next time the wizard is run click 

the Don’t show this dialog again checkbox. 
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Figure 5.50 – Additional Instructions for Fitting Data 

 

The configuration of the fitting parameters for the Integrate Rate Equation method 

(see Figure 5.51) and the Numerical method (see Figure 5.52) are quite similar. The 

difference between the two methods is that the Integrate Rate Equation method uses a 

separate set of fitting parameters for each interaction plot while the Numerical 

Modelling method uses one set of parameters for all plots. 
 

Numerical Modelling uses the Global Analysis technique in which all of the plots are 

fit at the same time to the same set of parameters values. The benefit of using global 

analysis is that it ensures that the selected model does in fact fit to the experimental 

data because the binding constants are the same in all interaction plots (only the 

concentrations differ). The initial values of the parameters are shown in Figure 5.52. 

 

 
 

Figure 5.51 – Integrated Rate Equation Parameters 
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Figure 5.52 – Numerical Analysis Parameters 

 

In certain numerical models, such as mass transport, the forward and reverse rate 

equations may need to be kept equal. The fit can be forced to fix one parameter equal 

to the value of another parameter. This can be accomplished by setting the value of 

the second parameter “=” sign and the name of the first parameter to which it should 

be fixed. This is shown in Figure 5.53. 

 

 
 

Figure 5.53 – Fixing a numerical fitting parameter 

 

In this case, the fit will be evaluated with K-1 always having the whatever value the 

fit finds for K1. 

 

To start the fitting process, after the initial parameters have been tested, click the Run 

button. During the fitting process the model plots (green lines) will be updated on the 

graph for each successful improvement in fitting to the experimental data. 

 

The Advanced button is used to configure the parameters of the fitting routine. The 

Advanced Setting dialog, shown in Figure 5.54, consists of the following parameters. 
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 Step Size – Step size between iteration 

 Number Steps – Number of steps with defined step size 

 Max. Iterations – Maximum number of iterations 

 

 
 

Figure 5.54 – Advanced Fitting Parameters 
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5.3.7 – Viewing the Analysis Summary 

 

The last step of the Analysis Wizard is a summary of the process that was executed. 

 

The figure below is a screenshot of the summary step for an Integrated Rate Equation 

analysis. The final parameters for each interaction plot are listed as well as the final 

modelling plot (green plots). 

 

To copy this data to another application use the Copy to Clipboard button. 

 

 

 
Figure 5.55 – Summary for the Integrated Rate Equation Fit 
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Figure 5.56 – Summary for the Numerical Analysis Fit 

 

Once fitting procedure has been completed it is possible to view the goodness of fit of 

the model using a Residual plot. To view the Residual plot, click PlotsResidual 

from the Toolbar as shown in the figure below. 

 

 
 

Figure 5.57 – Displaying the Residual Plot 

 

The Residual plot shows the difference between the model and experimental data. A 

model that is a good fit will have a residual plot where all the data points are 

randomly scattered around zero. 

 

Figure 5.58 is a screen shot of a Residual plot for the example data. From this plot we 

can see that the model selected does not fit the data. The next step would be to repeat 

the analysis process with the Biphasic model. 
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Figure 5.58 – Residual Plot 

 

The following figure is of an analysis in which the model fits the experimental data 

well. Notice that the residual plot in randomly scattered around zero. 

 

 
 

Figure 5.59 – Example of a Well Fitting Model 

 

The summary data will be saved with the analysis and added to the Project once the 

Close button on the wizard is clicked. The summary of the analysis will be still 

available by clicking on the Main Menu ViewSummary or by selecting the View 

Summary option in the Activity Bar. 
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5.3.8 – Equilibrium Analysis 

 

Equilibrium analysis uses a number of different steps from either Association or 

Dissociation analysis. 

 

 
 

5.3.9 – Equilibrium Analysis: Plots at Equilibrium 

 

The first distinction follows immediately after setting the start and end points for the 

plots. In step 4, each plot is fitted to see if it has reached equilibrium. First, a dialog 

discussing the fit appears, as shown in Figure 5.60. 

 

 
Figure 5.60 – Dialog indicating a fit for equilibrium will occur 

 

Once the dialog is dismissed, the user has the option to test each plot to determine if it 

is at equilibrium. The data table first shows the maximum value of Req determined 

from the data. The maximum value as estimated from a fit is not yet shown. To fit the 

data, click on the Fit button. This is shown in Figure 5.61. Each curve will be 

considered at equilibrium if: 

 Its maximum value from the data and from the fit are within the threshold 

value (in Figure 5.61, that is 1%), 

 Or the maximum value from the data is greater than the fit maximum value. 

The fit threshold can be changed in the text box if necessary. 

 

Note 

This section is for Equilibrium Analysis Only. 
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Figure 5.61 – Table of equilibrium plots before fitting for equilibrium 

 

Once the Fit button is clicked, each curve will be fit for equilibrium and the results 

presented, as shown in Figure 5.62. In the figure, the maximum from the fit is shown 

in the column next to data column. If the fit indicates that the plot is not at 

equilibrium, the Not at Equilibrium checkbox will automatically be checked. This is 

shown in the area marked 1 in Figure 5.62. 

 

Furthermore, the extrapolated fits will be shown in the area marked 2 in Figure 5.62. 

This is shown to aid the user in deciding the goodness of fit. If the user believes the 

plot is not at equilibrium, the user can check the Not at Equilibrium checkbox to use 

the value from the fit instead of the value from the data. 
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Figure 5.62 – Equilibrium via extrapolation 

 

5.3.10 – Equilibrium Analysis: Outlier Analysis 

 

Step 5 of an Equilibrium analysis will attempt to identify outlier points on the 

equilibrium plot. Outliers are identified by using a Lorentz fit as described in the 

paper by Motulsky and Brown
*
. Standard fitting techniques assume that the data 

points are Gaussian distributed around the true values. The Gaussian distribution has 

large “tails” and the fits are pulled by these tails to towards outliers. The Lorentz 

fitting technique replaces the assumption that the data points are Gaussian distributed 

with the assumption that the data points are Lorentz distributed. Because the Lorentz 

distribution has narrower “tails,” it is not affected by outliers to the degree that the 

Gaussian fit is. This technique allows for more robust identification of Outliers. 

 

On entry into Step 5, a dialog box is shown that indicates if the Lorentz fit identified 

any outliers. This dialog is shown in Figure 5.63. 

 

                                                 
*
 Motulsky and Brown, “Detecting outliers when fitting data with nonlinear regression – a new method 

based on robust nonlinear regression and the false discovery rate”, BMC Bioinformatics, 7:123 (2006) 
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Figure 5.63 – Dialog box indicating the presence or absence of outliers 

 

Figure 5.64 shows the results of the outlier analysis. The blue curve shows the fit 

using the Lorentz analysis. The red curve is the standard Gaussian fit. In the figure, 

the two curves are nearly identical, indicating that although the second data point 

might appear to be an outlier, it is not. 

 

 
 

Figure 5.64 – Outlier analysis showing the Lorentz fit (blue) and the standard Gaussian fit (red) 

 

The table on the left allows the users to manually exclude data points that the user 

believes are outliers. When a data point is excluded, the Lorentz curve (blue) remains 

the same, while the Gaussian fit (red) is updated to ignore the excluded points. Figure 

5.65 shows the plot with two excluded points (the red “X” data points). 
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Figure 5.65 – Outlier analysis with two excluded data points 

 

5.3.11 – Equilibrium Analysis: Analysis 

 

The last two steps of the Equilibrium Analysis do not require user interaction. Once 

the concentrations and start/end times are configured a Response at Equilibrium (Req) 

vs. Concentration graph will be plotted. 

 

By nonlinear fitting of the data in the Req vs. Concentration graph, as shown in Figure 

5.66, the affinity constant (KD) and Bmax values can be determined. 
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Figure 5.66 – Equilibrium Analysis 

 

The user can modify the results of the fit by making a depletion correction
*
. The 

depletion correction depends on the analyte molecular weight and the volume of the 

analyte in the Autolab SPR. By default, the analyte volume is 60 μl for the Autolab 

SPR. The effect of the depletion correction is shown in Figure 5.67. Here, a depletion 

correction was applied that changed both KD and Bmax. 

 

The standard way to apply a depletion correction is to first adjust all of the 

concentrations according to the formula: 

 

          
   

     
 

where S is the device surface area, α is the calibration constant, MA is the analyte 

molecular weight and V is the analyte volume. 

 

However, this would involve modifying the measured data. Instead, KE uses the fully 

integrated equilibrium equation
†
 

     
 

  
                                                  

   
  

     
 

                                                 
*
 See, for example, de Mol, N.J and Fischer, M.J.E, “Kinetic and Thermodynamic Analysis of Ligand-

Receptor Interactions: SPR Applications in Drug Development” Handbook of Surface Plasmon 

Resonance. Ed. Richard B.M. Schasfoort and Anna J. Tudos. Cambridge: RCS Publishing, 2008. 123-

172 
†
 See equation 23 of Edwards, P.R., et al, “Second-Order Kinetic Analysis of IAsys Biosensor Data: Its 

Use and Applicability” Anal Biochem, 263, 1-12 (1998). 
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Figure 5.67 – Equilibrium analysis after applying a depletion correction 

 

5.3.12 – Equilibrium Summary 

 

The last step in the Equilibrium Analysis is the summary. 

 

 
 

The Equilibrium Analysis summary step, as shown in the figure below, shows the 

fitted data on the Req vs. Concentration graph and the data points used to construct the 

graph. The affinity constant (KD) and the Bmax value are also presented. 

 

The data on the summary step can be transferred to another application by clicking the 

Copy to Clipboard button. 

 

Note 

This section is for Equilibrium Analysis Only. 
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Figure 5.68 – Equilibrium Summary 

 

The summary data will be saved with the analysis and added to the Project once the 

Close button on the wizard is clicked. The summary of the analysis will be still 

available by clicking on the Main Menu ViewSummary or by selecting the 

 View Summary option in the Activity Bar 

 

5.3.13 – Determine Concentrations 

 

The analysis wizard can be used to set the concentrations of a set of measurements by 

applying a concentration Calibration curve. Creating a Calibration curve is described 

in Section 6. 

 

To calculate the concentrations for a set of measurements from a Calibration, select 

“Determine Concentrations” on the first panel of the Analysis Wizard, as shown in 

Figure 5.69. 
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Figure 5.69 – Select Determine Concentrations 

 

The analysis wizard will proceed in four steps. Each step is similar to a step in the 

Equilibrium analysis, but the steps occur in a different order. Because setting the 

concentrations from a calibration curve uses an equilibrium analysis, the user should 

not use this method to set the concentrations if they then want to perform an 

equilibrium analysis (see section 5.3.2). Doing so will simply return the equilibrium 

analysis that was initially used to create the calibration curve. 

 

5.3.14 – Setting the Region to Analyze for Determining the Concentrations 

 

The concentrations are determined by fitting each of the measurements via an 

equilibrium analysis. Therefore the next step is to set the region to fit, as shown in 

Figure 5.70 

 

 
 

Figure 5.70 – Set the Start/End points for determining the concentrations 

 

5.3.15 – Determine plots not at equilibrium 
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The next step is to determine which plots are not at equilibrium. By clicking the “Fit” 

button as shown in Figure 5.71, the plots will be fit to a set of equilibrium curves. 

However, it is not required to try to determine if the curves are at equilibrium; if the 

“Max from Data” valid, the user can elect to continue to the next step by clicking the 

“Next” button. 

 

 
 

Figure 5.71 -- Apply Equilibrium fit to data 

 

If the user decides to fit the plots, the plot panel will show the data along with a 

regression curve, as shown in Figure 5.72. 

 

 
 

Figure 5.72 -- After Equilibrium fit 

 

Similar as was shown in the Equilibrium Analysis (Figure 5.62), the “Determine 

Calibrations” analysis will show plots not at equilibrium. The Not at Equilibrium 

checkbox will automatically be checked. This is shown in the area marked 1 in Figure 

5.72. Furthermore, the extrapolated fits will be shown in the area marked 2 in Figure 

5.72. This is shown to aid the user in deciding the goodness of fit. If the user believes 

the plot is not at equilibrium, the user can check the Not at Equilibrium checkbox to 

use the value from the fit instead of the value from the data. In Figure 5.72, only 

“KIN101 Differential” (the red plot) is considered to be Not at Equilibrium. 
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5.3.16 – Apply the Calibration file 

 

The final step of determining the concentrations is to apply the calibration curve to the 

equilibrium data. This process is shown starting in Figure 5.73. 

 
 

Figure 5.73 -- Applying the Calibration curve 

 

Initially, the user must select a calibration to use to calculate the concentrations. The 

user can select to use 

 A Calibration file (.kcf) loaded from disk, as shown in the circled “Browse” 

button 

 A previously loaded Calibration, which will be shown in the “Use existing 

calibration” combo-box. 

 

Once a calibration is selected, the calculation can be executed, as shown in the circled 

“Execute” button in Figure 5.74. 

 

 
 

Figure 5.74 -- Loading a Calibration File in preparation to execute the calibration 

 

Once the concentration calculation is completed, the calculated concentrations will be 

shown in the table (circled in Figure 5.75). In addition, the calibration curve will be 

shown, with blue data points for the original calibration curve data, and pink points 
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for the calculated concentrations. This plot is shown in more detail in Figure 5.76 

after the “Legend” button in the Toolbar was pressed. 

 

 
 

Figure 5.75 -- Calibration after calculating the concentrations 

 

 
 

Figure 5.76 -- Concentration curve showing the calculated concentrations after the “Legend” 

button was pressed 

 

It is possible that a given calibration curve cannot be applied to the current data. This 

situation can occur when the Requilibrium of the extrapolated data from Step 3 is greater 

than the BMax of the calibration curve. In this case, the warning dialog shown in Figure 

5.77 will appear. 
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Figure 5.77 -- Warning for invalid concentration calculation 

 

This inconsistency is shown in Figure 5.78. The Requilibrium for “KIN105” is 357.41, 

which exceeds the BMax of the calibration curve (which is roughly 340). In this case, it 

is not possible to calculate a concentration for “KIN105”, and that entry is empty in 

the table. 

 

 
 

Figure 5.78 -- Missing concentration 

 

At this point, the user should load a different calibration curve and execute a new 

concentration calculation. 
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6 – Calibration Analysis 

 

Calibration analysis is a special kind of equilibrium analysis. It is used to derive a 

calibration curve that can be applied to Association or Dissociation measurements to 

determine the concentration values. 

6.1 – New Calibrations 

 

To begin a calibration, select New Calibration, either from the activity bar as shown 

in Figure 6.1, or from the File menu. This will start the process to create a new 

calibration project. 

 

 
 

Figure 6.1 – Creating a calibration project 

 

Once the New Calibration is selected, the Calibration Builder dialog box is shown. 

The Calibration builder is shown in Figure 6.2. Just like in the Project builder, the 

user can select to add either an opened overlay file, or to import an overlay from a file 

on disk. 
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Figure 6.2 – The Calibration Builder dialog. 

 

6.2 – The Calibration Wizard 

 

Once the Calibration Builder is completed, a new calibration project is created. This 

project is shown in Figure 6.3 and it is very similar to a default project. However, only 

Signal Processing and the Calibration Wizard are available for calibration projects. 

 

 
 

Figure 6.3 – A newly created calibration project 

 

To launch the Calibration Wizard, select Calibration Wizard from the Activity bar 

as shown in Figure 6.4. 
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Figure 6.4 – Launching the Calibration Wizard from the Activity bar 

 

The Calibration Wizard is similar to the Analysis Wizard (see section 5.3) but it only 

runs a simplified equilibrium analysis. 

 

6.3 – Specifying the Concentrations 

 

As with the Equilibrium analysis, the first step is to set the concentrations, as shown 

in Figure 6.5. 

 

 
 

Figure 6.5 – Plot Concentrations for the Calibration Wizard 

 

6.4 – Specifying the Start/End Times of the Analysis 

 

Step 2 is to set the plot ranges, as shown in Figure 6.6. This procedure is the same as 

procedure for a regular analysis. 
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Figure 6.6 – Setting the plot ranges for a Calibration project 

 

6.5 – Extrapolation to Equilibrium 

 

Step 3, as shown in Figure 6.7, determines any plots that are not at equilibrium by 

fitting the data. The fit is accomplished by pressing the Fit button.  Any plots not at 

equilibrium will be checked in the Not at Equilibrium column. The fit extrapolations 

are shown in the plot area. 
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Figure 6.7 – Equilibrium extrapolation for a Calibration project 

 

6.6 – Outlier Analysis 

 

The calibration analysis looks for outliers in exactly the same way that the 

Equilibrium analysis looks for outliers, using the Lorentz fit. The outlier analysis is 

shown in Figure 6.8. 

 

 
 

Figure 6.8 – Outlier analysis for a Calibration project 
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6.7 – Equilibrium Fit 

 

Step 4 is the Equilibrium fit for the Calibration project. Figure 6.9 shows the fit to the 

data. 

 

 
 

Figure 6.9 – The Equilibrium analysis for a Calibration 

 

6.8 – Summary 

 

Figure 6.10 shows the summary for the Calibration analysis, with the fit values for 

Bmax and KD. These values can be extracted to the clipboard if necessary. 
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Figure 6.10 – Summary of a Calibration Analysis 

 

Figure 6.11 shows the Calibration project in the main KE window. In the right panel 

is the project navigator; here we have a Calibration file with the extension .kcf, the 

overlay from which the calibration was derived, and the one calibration analysis under 

the node Calibration. 

 

 
 

Figure 6.11 – A Calibration Project with one Calibration Analysis 
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6.9 – Using Calibration Files 

 

As discussed in section 5.3.2, one can use calibration files saved to a .kcf file to set 

the concentrations of an Association or Dissociation analysis.  
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7 – Van’t Hoff Analysis Wizard 

7.1 – Introduction 

 

Van’t Hoff analysis is a technique that links changes in the affinity constant (KA) with 

respect to temperature to the thermodynamic properties ΔH, ΔS and ΔCp (Delta 

Enthalpy, Delta Entropy and Delta Heat Capacity). 

 

The integrated Van’t Hoff equation is: 
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In Equation 7.1 the logarithm of the affinity constant is related to (1/T) and the 

constants ΔH, ΔS and ΔCp, where each constant is evaluated at a reference 

temperature T (typically 25 C). Since there are three free parameters, at least four 

measurements of KA at different temperatures are required to over –constrain the three 

fitted constants. This requirement means that the user should measure Req versus Time 

for five concentrations, at four separate temperatures (typically in the range 10 – 40 

C), for a total of at least 20 measurements. 

7.2 – Creating a Van’t Hoff Project 

 

A Van’t Hoff Project is created through the New Project builder. Select New Project 

from the Activity bar, or FileNew Project (Including Van’t Hoff Projects) … from 

the File Menu. These actions will launch the New Project builder, as shown in Figure 

7.1 

 

 
 

Figure 7.1 – The New Project builder with the Van’t Hoff option selected. 

 

Select the Create New Van’t Hoff Project radio button and click OK. This action 

will launch the Overlay importer. 
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7.3 – Importing Overlays 

 

The Van’t Hoff analysis requires at least four overlays. Each overlay corresponds to 

multiple measurements (each taken at different concentrations), with each set of 

overlay measurements taken at the same temperature. 

 

The Van’t Hoff Project Builder is shown in Figure 7.2. The Van’t Hoff Project 

Builder will allow the user to import multiple Overlay files. These overlay files will 

either be already open in KE (as shown in the figure), or can be imported from disk. 

Van’t Hoff Projects are the only projects that allow multiple overlay files to be added 

to the same project file. 

 

 
 

Figure 7.2 – The Van’t Hoff Project Builder, used to import multiple overlay files to a Van’t Hoff 

Project. 

 

Once the overlay files are selected, the user can import the overlay files into the Van’t 

Hoff project by clicking OK. The Van’t Hoff project will then be displayed in the 

main KE window. The Project Navigator shows the new Van’t Hoff project 

(VantHoffProject1.kvf) with the five imported overlays. Each overlay corresponds to 

measurements taken at a single temperature. The Van’t Hoff project is the only 

project type where multiple overlay files can be imported into one project. 
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Figure 7.3 – The Van’t Hoff Project in the main KE window. 

 

At this point, one could execute Signal Processing on each of the overlay files, if 

necessary. Signal Processing is discussed in Section 5.2. 

 

7.4 – Saving and Loading Van’t Hoff Projects 

 

Van’t Hoff Projects are saved with a .kvf file extension. These project files can be 

loaded from the Open Files Activity bar by selecting Projects or from 

FileOpenProject (including Van’t Hoff Projects)…  By default, the Open file 

dialog will default to regular Project files with a .kpf file extension. The user can 

change this to the .kvf file extension as shown in Figure 7.4 to load Van’t Hoff Project 

files. 
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Figure 7.4 – Selecting Van’t Hoff Project Files (*.kvf) to load in the Open File dialog. 

 

7.5 – Van’t Hoff Equilibrium Analysis 

 

The Van’t Hoff analysis uses affinity data in the calculation. To provide the affinity 

information, each Overlay file must go through an Equilibrium analysis using the 

Analysis Wizard, as discussed in Section 5.3.8. 

 

To launch the Analysis Wizard, select it from the Activity Bar, as shown in Figure 

7.5. 

 

 
 

Figure 7.5 – Selecting the “Analysis Wizard” 
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This action will launch the Analysis Wizard, which is discussed in detail in Section 

5.3. There is one significant difference between a default Analysis and one in the 

Van’t Hoff project. Because the user can import multiple overlay files in a Van’t Hoff 

analysis, the first panel of the Analysis wizard will allow the user to select the overlay 

to analyze from a drop-down combo box, as shown in Figure 7.6. 

 

 

 
Figure 7.6 – Selecting the overlay for a new analysis in a Van’t Hoff Project 

 

For the second and subsequent analyses, the wizard will either allow the user to create 

a new analysis from a selected overlay file, or to open a previously-created analysis, 

as shown in Figure 7.7. 
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Figure 7.7 – Selecting to either create a new analysis or open an existing analysis in a Van’t Hoff 

Project. 

 

The equilibrium analysis process must be repeated for each overlay file in the Van’t 

Hoff Project file. Figure 7.8 shows the results for the project after this process is 

complete. There are seven overlay files and seven equilibrium analyses. 
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Figure 7.8 – The Van’t Hoff Project in the main KE window after all the equilibrium analyses are 

complete. The project navigator shows seven overlay files and seven analyses. 
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7.6 – Van’t Hoff Analysis Wizard 

 

Once the requisite equilibrium analyses are completed, the user can launch the Van’t 

Hoff Wizard, by selecting Van’t Hoff Wizard from the Activity bar. This is shown in 

Figure 7.9. 

 

 
 

Figure 7.9 – Launching the Van’t Hoff Wizard from the Activity bar. 

 

Step 1 of the Van’t Hoff Wizard is to select the KA fits that will be used in the Van’t 

Hoff Analysis. Figure 7.10 shows the first panel of the Van’t Hoff Wizard. On the left 

is a table of the Equilibrium Analyses. The first column of the table shows the 

temperature of measurement.  

 

The temperature is the average of the temperature measurements in each of the 

measurement in the given overlay. If the standard deviation of the temperature 

average is greater than the Temperature Variation Threshold, the analysis will not be 

used by default. This means that the Include column will be unchecked. 
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Figure 7.10 – Initial panel of Van’t Hoff Wizard. 

If the user adjusts the Temperature Variation Threshold, the wizard will automatically 

exclude measurements whose standard deviation is larger than the threshold. In Figure 

7.11, the threshold has been set to an arbitrary low number, and all the analyses have 

been automatically excluded. 

 

 

 
Figure 7.11 – Adjusting the Temperature Variation Threshold may exclude overlays whose 

temperature standard deviation shows too much variation. 

 

Because the Van’t Hoff Analysis requires four KA data points to over-constrain the 

three constants in the fit, if the user includes less than four analyses, the Next button 

will be disabled, as shown in Figure 7.12. 
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Figure 7.12 – Van’t Hoff analysis requires four equilibrium analyses. Including less than four will 

disable the “Next” button. 

 

Step 2 of the Van’t Hoff analysis is to do the actual fit. Click on the Next button to 

show the second panel of the Van’t Hoff Wizard. This panel is shown in Figure 7.12. 

 

The results of KA versus (1/T) are plotted in the graph window. The results for the fit 

to Equation 7.1 are shown in the summary area. The results for ΔH, ΔS and ΔCp, as 

evaluated at the reference temperature T, can be copied to the clipboard for 

importing into other programs. 
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Figure 7.12 – The results of the Van’t Hoff Analysis. 

 

Once the analysis is complete, the Van’t Hoff Project can be saved. 
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8 – Monte Carlo Wizard 

8.1 – Introduction 

Monte Carlo is a technique that uses pseudo-random numbers to vary the fit. This 

technique is used to cross-check the results of the fit for consistency, and also to 

validate the error estimates for the fit. 

 

Under the Monte Carlo technique, the fit is run multiple times under differing 

conditions. The result of each “run” of the fit is then compared to the original fit. 

 

Kinetic Evaluation has a Monte Carlo Wizard that can generate two types of Monte 

Carlo simulations: 

1. Vary initial parameters: for each run of the Monte Carlo, the starting points of 

the fit are varied by a percentage fraction of the fit values. The fits are then 

tested to see if the fit converges to the same final fit values. 

2. Add noise to the data: for each run of the fit, a random amount of “noise” is 

added to each data point. Because the data is modified, the fit will typically 

converge to a different result. However, the average value of all of the Monte 

Carlo fits should be consistent with the original fit value. 

8.2 – Running the Monte Carlo Wizard 

To run the Monte Carlo wizard, select an existing analysis within a project. Select 

“Monte Carlo Wizard”. 
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8.1– Selecting the Monte Carlo Wizard 

 

Selecting “Monte Carlo Wizard” will launch the Monte Carlo Wizard. 

 

 

 

8.2 – The Monte Carlo Wizard 

 

The wizard has the two options discussed above. Each of these options will be 

discussed below in the following sections. One feature common to both types of 
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Monte Carlo runs is the number of runs that will be executed for the Monte Carlo. The 

default number of runs for integrated equations is 100. For numerically integrated 

equations, the default is 25. The numerically integrated equations use a lower default 

as they are more computationally intensive. The user can change the default number 

of runs. 

 

8.2.1 Monte Carlo Analysis of Numerically Integrated Fits 

 

If the user has selected a Monte Carlo analysis of a fit that uses numerical integration, 

they will see an initial warning: 

 

 
 

Figure 8.3 – Numerical Integration warning 

 

If the original fit was run against a numerical model that cannot be found by KE, the 

user will see this warning 

 

 
 

Figure 8.4 – Cannot find model 

 

The Monte Carlo wizard cannot continue. The user should refit the data using the 

Analysis wizard before attempting to use the Monte Carlo wizard. 

8.3 – Run the Monte Carlo 

 

The second panel of the Monte Carlo wizard is shown in Figure 8.5. The Wizard 

shows one histogram for each parameter in the fit. In this example, there are three 

floated parameters in the fit, Ks, E and R(0). For each run of the Monte Carlo, an 

entry will be added to the histogram for each parameter. 

 

The table on the left shows one tab for each plot that is fit. In the table are listed the 

three parameters of the fit, along with the original fit value, the average of all Monte 

Carlo runs, and the standard deviation of the Monte Carlo runs. 
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Once the user clicks the “Start” button, the Monte Carlo will commence. 

 

 
 

Figure 8.5 – Start of running the Monte Carlo 

 

Once the user clicks “Start” the Monte Carlo runs begin. There is a progress bar that 

indicates the number of completed runs. While the Monte Carlo is running, all buttons 

except the “Stop” button are disabled. 

 

As the runs progress, the table of the Monte Carlo average and standard deviation are 

updated. The histograms also update as a Monte Carlo run is completed. This progress 

is shown in Figure 8.6. 
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Figure 8.6 – The Monte Carlo wizard when the Monte Carlo is running 

 

Figure 8.7 shows the second panel of the Wizard when all runs of the Monte Carlo 

have finished. A Gaussian plot with the average and standard deviation of the 

parameter values is overlaid on each histogram. 

 

 
 

Figure 8.7 – The Monte Carlo run completed 
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8.3.1 – Vary the Start Parameters 

 

The first option for the Monte Carlo is to vary the starting point of the fit. In this 

option, the parameters that are used as starting points for the fit are varied by the 

specified percentage (although they are not varied negative). The fits are then run to 

determine if the final parameters that are determined from the fit are the same as from 

the original fit. 

 

This technique allows the user to determine if the original fit found a “local 

minimum” of the fit, or if the original fit converged to an absolute minimum. If all of 

the varied parameter runs end up converging to the same set of final parameters, the 

user has confidence that the reported parameters are the best fit for the given model. It 

is important to realize that the presence of only one set of final parameters does not 

mean that the chosen model is a good fit to the data. It only means that there is one set 

of parameters that work for that model. 

 

This technique is not a true Monte Carlo because the actual data is not modified. 

8.3.2 – Add Noise to the Data. 

 

The second option for the Monte Carlo is to use a random number generator to add a 

random amount of noise to the actual data. Here the data points are changed. The 

noise is selected from a Gaussian distribution with a standard deviation equal to the 

“noise” factor input by the user. 

 

Figure 8.8 shows the result of a “noise” Monte Carlo where 10 millidegrees of noise 

was added to the data. The fits show that the Monte Carlo average is very similar to 

the original fit values. The standard deviation of the Monte Carlo values is larger than 

the estimated uncertainties on the original fit due to the addition of the 10 millidegrees 

of noise in the data. 
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Figure 8.8 – Monte Carlo results for "noise" fit 

8.4 – Monte Carlo Summary 

 

The final panel of the Monte Carlo wizard (shown in Figure 8.9) summarizes the 

Monte Carlo run. 

 

 
 

Figure 8.9 – Monte Carlo Summary Panel 
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The user can copy the results of the Monte Carlo runs to the clipboard. These results 

can be pasted into a text editing program or a spreadsheet such as Microsoft Excel. 

The summary will show the Chi Squared for each run of the fit, and the parameter 

values. 

 

 

 
 

Figure 8.10 – "Copy to Clipboard" results 
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